usse

Blaster Port  Device

12V DC Power
Supply Connector

Power ONJOFF Switch

Altera USB Blaster
Controller chipset

USB HosVSlave
Controller

ARera EPCS64
Configuration Device

LCD 16x2 Module

FIFT

)

G Quartus Prime Lite Edition

File Edit View Project Assignments

Ors r

DE2-115 0'VUY> NV Quartus -2 17 DN

Audio TV Decoder  28MHz
CODEC (NTSC/PAL) Osciliator
Ethemet Ethemet
usB USB Mic Line Line Video VGA 10/100/1000M  10/100/1000M  RS-232
Host In In  Out in Out Port 0 Port 1 Port

PS2 Port
VGA 24-bit DAC
Gigabit Ethernet PHY

Expansion Header (J15)
(with Protection Diodes)

HSMC Connector

Altera 60-nm Cyclone IV E
FPGAwith 115K LEs

S50MHz Oscillator

SMA Ext Clock Out

i g | SMA Ext Clock In
S REIEERIEIEIEEL AlRlEL

IR Receiver

18 Red LEDs 18 Skde Switches 64MB

SORAM x2

2MB 4 Push-button 8MB
SRAM FLASH
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LEDs

QUARTUS Prime 18.1.0 Lite Edition

Processing  Tools Window Help

eavule

Project Navigator | 4\ Hierarchy.

valge x| @& Home

i Compilation Hierarchy

Recent Projects

nux2tol.qpf (E/quar18lite/de10/mux2to/mux2to1.qpf)
led_1sec.qpf (E/quarislite/de10/led_1sec/led_1secqpf)
Ccountoto9.qpf (E/quart 8lite/count0tag/countotog.apf
mux4to1_syn.qpf (E/quar18lite/mux4to_syn/mux4toT_syn.qph

New Project Wizard Open Project

Buy Saftvare Support \What's New Natifications

after project load

¢ this screen again

& |

0| |4 4

A e ]

Quartus Prime Tc1 Console

B8 rind. | 8 Find Next

Message
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N1dIND DY ATIAYA NIV NITIA
D100 N1y NMI90 NI¥PNY? 'R .1

NTI9 N'P'N y'min project 707 .2

nnhv
File => New Project Wizard - project NnNn'no o

Ok New Project Wizard *

Introduction

The New Project Wizard helps you create a new project and preliminary project settings, including the following:

Project name and directory

Name of the top-level design entity
Project files and libraries

Target device family and device
EDA tool settings

* 4+ e

‘You can change the settings for an existing project and specify additional project-wide settings with the Settings command (Assignments
menu). You can use the various pages of the Settings dialog box to add functionality to the project.

1 Don't show me this introduction again

< Back Finish Cancel Help

(8 New Project Wizard x

Directory, Name, Top-Level Entity

‘What is the working directory for this project?

|D:\edu‘lQ\Vhdt\quaﬂus\mulea‘l |

‘What is the name of this project?

|mux2to‘|| |

‘What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the

design file.

|mux2ta‘| |

Use Existing Project Settings...

< Back FEinish Cancel Help

AYONT7 , N7 XY WUzan N'dINN
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(S New Project Wizard
Project Type

Select the type of project to create.

@® Empty project
Create new project by specifying project files and libraries, target device family and device, and EDA tool settings.
O Project template

Create a project from an existing design template. You can choose from design templates installed with the Quartus Prime software, or
download design templates from the Design Store

< Back | MNext > Einish || Cancel H Help

G New Project Wizard

Add

es

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project.

Note: you can always add design files to the project later.

- ]
o X\ Add All

FileName Type Library Design Entry/Synthesis Tool HDL Version

Remove

Up

Down

Specify the path names of any non-default libraries

Properties

I e

[>1 INXY7 Yal 9

DE2-115 0'uvd%7 O'XNNN 2D N2

G New Project Wizard
Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation
You can install additional device support with the Install Devices command on the Tools menu

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in "Available devices' list

Eamily{| Cyclone v E I - Package ‘N\N _‘

Devjce: [All " Pincount ‘Any - ‘
Target device Care speed grade: | Any -
® Auto device selected by the Fitter Name filter [ |

O Specific device selected in *Available devices' list

Show advanced devices

other: nfa

Available devices

Core Voltage LEs Total /05 GPIOs Memary Bits Embedded multiplier 9-bit *
EP4CE115F29C7 |12V 114480 529 529 3981312 532 v

< >

~
Net> || Emish || cancel || helo
)

X I'n

https://hayunavi.wixsite.com/avihayun

DE2-115 17 PN


https://hayunavi.wixsite.com/avihayun

1-2 2 MUX %7150 ,Xan 7ayna DX D17 ANVN

vce

—| KEY0 c P T 1
I | :
= = . Do !
b I
PIN_G26 | | PIN_AE23
! i
I
‘ i
vee PIN.N23! i
b D1 i
! i
! i
R i i
[
PIN_N25
vcc
_| - I C i
= = SWo —0—

.N1222 7'won XXINA LED -1 170910, D'UILM Ny 2ayn oy 01xN7n yTNn nNiotd

File =>New wTn yalp nno

VHDL 210 "'n2

Project Navigato] i\ Hemrchy 7 QB8 x

EntitylInstance

S New

&% Cyclone IV E: EPACE115F29CT

ES ]
muxztel New Quartus Prime Project

¥ DesignFiles
AHDL File
Block Diagram/Schematic File
EDIF File

Qsys System File

State Machine File
SystemVerilog HDL File
Tel Script File

[Tasks compilation MEIE:R Verlog HOL File

Task ~ VHDL File
v b complen ¥ Memory Files
ompile Design

" ® Hexadecimal (intel-Format) File

5 B analucic 2 Gunthacic

:EDITOR -n 10N NXAN NDINN DX 2IND

library ieee;
use ieee.std logic 1164.all;

entity mux2tol is
port( DO,Dl: in std logic;
SEL: in std logic;
F: out std logic);
end mux2tol;

architecture arc mux of mux2tol is
begin

F<=D0 when SEL ='0' else

D1 ;
end arc mux;
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Q, muxZtol NP N2 WI9N

2] -~ :f

Ao

O'Y3P NPT

File =>Save As Yalpn DR INY

[ IRY

1M RN

01/11/2019 00:05

nean apm

ow N

db

oun AN

mux2tol < vhdl < (E)'nipnpoT » ™

~ 70
n-nn oprak
nmin 4
npon
onoD
oo [
amawn (o Bl
ninn =
(C) 'Ipn poT
05 (D7)
(E:) 'DIPN POT o

——

~|y2p ow

WVHDL Files (*.vhd *.whdl)

Do

Add file to current
project

| A0 e

nrgrnanon A

entity Level Top - NNI2aN N'DI'NN 7Y DWN RINY VR'NSN DWD yalzn Y oW

Ok Quartus Prime Lite Edition - E:/vhdl/musx2tol/mux2tol - muxtol

Processing  Tools

Window Help

Yalgn DX 7907 e

seseaf)rio osvule

mux2tel.vhd

File Edit View Project Assignments
D I~ I' nCc mux2tol
Project Navigator | 4% Hierarchy ralne x| &
1
Entity:Instance o
3
A% MAX 10: 1OMOBDAF484C8G 4
F mux2tol B g
7
8
9
10
11
12
13
14
15

Quartus Prime Lite Edition - E:

Ormd il ls

Tibrary ieee;
use jeee.std logic_1164.all;

Hentity mux2tol is
=] port{ DO,D1: in std_Tlogic:
SEL: in std_logic;
F: out std_logic);
end mux2tol;

Barchitecture arc_mux of mux2tol is
Bbegin

F<=D0 when SEL ='0" else
Dl ;
end arc_mux;

NN7IM'07 NI WTN YAl NN e

mutel/muwto] - mux2tel

mux2tol S EEL D FES BAVE 9
Project Navigator |+ Hierarchy ~alge < ¢ — Compi
G New X
Entity Instance Table of Conte
% MAX 10: 10MOBDAF484CEG B3 Flow State Machine File ~
BB il T EH Flow SystemVerilog HOL File s
EH Flow Tel Script File Fsion 1€
EH Flow Verilog HDL File o
EH Flow VHDL File ame m
v

@ Flow Memory Files M
> B Aty Hexadecimal (Intel-Format) File .

Memory Initialization File
> [ Fitter X R Fit

° ¥ Verffication/Debugging Files
Flovg In-System Sources and Probes File 3 ]
O Flow Logic Analyzer Interface File @
> I Assen o File N
> M Timin, [}
v 0,
AHDL Include File ier 9-bit elements 0,
Block Symbol File o,
Chain Description File al

e Ele ¥
< > < — o0z Desien Constraints File~| 0
| x |Quartus prime Tcl console Cancel Help

N2 ,Name 1ITR2 N2Dya "n! Yn'? °

N |I'n
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Yalue at Ops E'O'? =
MName
Ops 0 ps
# Delete Del

Grouping

]

Edit N IW7 JINNn N7 IX

a Simulation Waveform Editor - E:/quarl8lite/muxtel/muxte] - muwtol - [Wav

File View  Simulation Help

_Ex Delete pel 7 YR

wase e nsatNedeorsus. |

Value L
_ 50.0 ns 3200 ns
Grouping b 0 [
(% Insert Node or Bus *
Mame: ‘Use Node Findertoinsert...| ‘ OK ‘
. al=a

Value type: ‘ 9-Level

Radix: ‘ Binary

=)

Bus width: ‘1

Start index: ‘0

Display gray code count as binary count

X I'N

https://hayunavi.wixsite.com/avihayun

DE2-115 a7 PN


https://hayunavi.wixsite.com/avihayun

a MNode Finder

x
Mamed: [* |Filter ‘Pins:all - | OK |
Lookin: |* ‘D | Cancel ‘
Nodes Found: Selected Nodes:
W ¥
Name Type MName Type
O Node Finder >
Mamed: |* | Filter: ‘P‘ins: all " | OK |
Look in: |* ‘EI ‘ List | ‘ Cancel ‘
Nodes Found: Selected Nodes:
¥
MName Type Mame Type
iﬁ_ Do Input
& D1 Input .
wor Output [
in &
= SEL Input
i
i@ Node Finder *
Named: |* | Filter: |Pins: all v| OK
Look in: [* | D | List | Cancel
Nodes Found: Selected Nodes:
Mame Type Type
iﬁ_ Do Input nput
iﬁ_ D1 Input Input
S F Output Output
B SEL Input Input

X I'N
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(@ Insert Node or Bus *,
MNarne: ==Multiple ltems** k oK }
Type: *=Multiple ltems** - Cancel
Value type: | 9-Level -

Node Finder...
Radix: Binary
Bus width: |‘I |
Start index: |D |

AI'RN 97 SEL, D1 -7 200nsec , DO-7 100nsec AT [IVY XNAIT? , D'72 010N

QR A ZOEE B E(E R R g 2 [ B

Master Time Bar: |D ps | 1 } | Pointer |?.DS ns | Interval: |7.06 ns
Value at 0 ps 809 ns ‘IGOiO ns 240i0 ns 320i0 ns 400i0 ns
MName
0ps 0 ps
& DO BO b
_ il Clock ®
- [ad BO ]
% F BX Base waveform on time period
B SEL BO Period: | 1000 ns v |
cancel
valvest | [0PS 800ns 160.0ns 240,0ns 3200ns 4000 ns 4800 ns 560,0ns 640,0ns 7200ns 8000 ns 880.0ns 960,0ns
Name ope ops
» Do B0 | J | J [ J
- D1 BO
W f B anaeatscy e
B SEL BO [ \
2070 NN X7 y
CVE 07 WA e e 2 [ B
|— - W l e A
4 3 Fimimdme | D00 O -
[AIoNnY7 |''m T9N 7Y YN ,2'70 7w NIfwnn AT Dy N¥1 DX
NXIN MNKX
Value at 0 ps 80. ? ns ‘\SOIO ns 240‘0 ns 320‘0 ns 400I0 ns 4&0‘0 ns 550‘0 ns S4¢0IO ns 720‘0 ns 500‘0 ns BﬂOIO ns
Name ops oo
i o s \ \ \ \ [ \ J L J L J L \ L \ \ \
= D B0
- F B0 | J | J | J
B SEL BO [ |

D1 7w yTnn nX 1-21 DO 7w yTMn NX SEL=0-2 1'ayn 270w D'RN
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Table 4-1 Pin Assignments for Slide Switches

Signal Name FPGA Pin No. Description 0 Standard

SW[0] PIN_AB28 Slide Switch[0] Depending on JPT
SW[1] PIN_AC23 Slide Switch[1] Depending on JPT
SW[2] PIN_AC27 Slide Switch[2] Depending on JPT
SW[3] PIN_AD27 Slide Switch[3] Depending on JPT
SW[4] PIN_AB27 Slide Switch[4] Depending on JPT
SW[5] PIN_AC26 Slide Switch[5] Depending on JPT
SW[6] PIN_AD26 Slide Switch[6] Depending on JPT
SW[T] PIN_AB26 Slide Switch[7] Depending on JPT
SW[B] PIN_AC25 Slide Switch[8] Depending on JPT
SW[9] PIN_AB25 Slide Switch[9] Depending on JPT
SW[10] PIN_AC24 Slide Switch[10] Depending on JPT
SW[11] PIN_AB24 Slide Switch[11] Depending on JPT
SW[12] PIN_AB23 Slide Switch[12] Depending on JPT
SW[13] PIN_AA24 Slide Switch[13] Depending on JPT
SW[14] PIN_AA23 Slide Switch[14] Depending on JPT
SW[15] PIN_AA22 Slide Switch[15] Depending on JPT
SW[16] PIN_Y24 Slide Switch[16] Depending on JPT
SW[17] PIN_Y23 Slide Switch[17] Depending on JPT

Table 4-2 Pin Assignments for Push-buttons

Signal Name FPGA Pin No. Description VO Standard

KEY[0] PIN_M23 Push-button[0] Depending on JPT
KEY[1] PIN_M21 Push-button[1] Depending on JPT
KEY[2] PIN_N21 Push-button[2] Depending on JPT
KEY[3] PIN_R24 Push-button[3] Depending on JPT
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Signal Name
LEDR[0]
LEDR[1]
LEDR[2]
LEDR[3]
LEDR[4]
LEDR[3]
LEDR[6]
LEDR[T]
LEDR[8]
LEDR[9]
LEDR[10]
LEDR[11]
LEDR[12]
LEDR[13]
LEDR[14]
LEDR[15]
LEDR[16]
LEDR[17]
LEDG[0]
LEDG[1]
LEDG[Z]
LEDG[3]
LEDG[4]
LEDG[5]
LEDG[6]
LEDG[T]
LEDG[8]

N |I'n

10

Table 4-3 Pin Assignments for LEDs

FPGA Pin No. Description
PIN_G19 LED Red[0]
PIN_F19 LED Red[1]
PIN_E19 LED Red[2]
PIN_F21 LED Red[3]
PIN_F18 LED Red[4]
PIN_E18 LED Red[5]
PIN_J19 LED Red[6]
PIN_H19 LED Red[7]
PIN_J17 LED Red[8]
PIN_G17 LED Red[9]
PIN_J15 LED Red[10]
PIN_H16 LED Red[11]
PIN_J16 LED Red[12]
PIN_H17 LED Red[13]
PIN_F15 LED Red[14]
PIN_G15 LED Red[15]
PIN_G16 LED Red[16]
PIN_H15 LED Red[17]
PIN_E21 LED Green[0]
PIN_E22 LED Green[1]
PIN_E25 LED Green[2]
PIN_E24 LED Green[3]
PIN_H21 LED Green[4]
PIN_G20 LED Green[5]
PIN_G22 LED Green[6]
PIN_G21 LED Green[7]
PIN_F17 LED Green[8]

HEX0{0]
WV

HEX0{1]
HEX0{2)

Hi )
o EXO{3)

WV

y a HEXO(4)
MEXO(S)
HEXM0)

IO Standard
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V
2.5V

JAITERAN

Cycione' IV
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|Signal Name
'HEX0[0]
HEXO0[1]
HEX0[2]
'HEXO0[3]
HEX0[4]
'HEXO[5]
'HEX0[6]
HEX1[0]
HEX1[1]
HEX1[2]
HEX1[3]
HEX1[4]
HEX1[5]
'HEX1[6]
HEX2[0]
HEX2[1]
HEX2[2]
HEX2[3]
HEX2[4]
HEX2[5]
HEX2[6]
'HEX3[0]
HEX3[1]
HEX3[2]
HEX3[3]
HEX3[4]
HEX3[5]
'HEX3[6]
'HEX4[0]
HEX4[1]
HEX4[2]
HEX4[3]
'HEX4[4]
'HEX4[5]
'HEX4[6]
'HEX5[0]
'HEX5[1]
HEX5([2]
HEX5[3]
'HEX5[4]
'HEX5[5]
'HEX5[6]
'HEX6{0]
HEX6[1]
'HEX6[2]
HEX6[3]
'HEX6[4]
'HEX8[5]
'HEX6[6]
HEXT[0]
HEXT7[1]

11

Table 4-4 Pin Assignments for 7-segment Displays

FPGA Pin No.

PIN_G18
PIN_F22
PIN_E17
PIN_L26
PIN_L25
PIN_J22
PPIN_H22
PIN_M24
PIN_Y22
PIN_W21
PPIN_W22
PIN_W25
PIN_U23
PPIN_U24
PPIN_AA25
PPIN_AA26
PIN_Y25
PIN_W26
PPIN_Y26
PIN_w27
PIN_W23
PIN_v21
PPIN_U21
PPIN_AB20
PIN_AA21
PIN_AD24
PIN_AF23
PIN_Y19
PIN_AB19
PIN_AA19
PIN_AG21
PIN_AH21

PIN_AE19
PIN_AF19
PIN_AE18
PIN_AD18
PIN_AC18
PIN_AB18
PIN_AH19
PIN_AG19
PIN_AF18
PIN_AH18
PIN_AA1T
PIN_AB16
PIN_AA16
PIN_AB17
PIN_AB15
PIN_AA15
PIN_AC17
PIN_AD17
PIN_AE1T

N |I'n

Description

Seven Segment Digit 0[0]
Seven Segment Digit 0[1]
Seven Segment Digit 0[2]
Seven Segment Digit 0[3]
Seven Segment Digit 0[4]
|Seven Segment Digit 0[5]
|Seven Segment Digit 0[6]
|Seven Segment Digit 1[0]
|Seven Segment Digit 1[1]
|Seven Segment Digit 1[2]
|Seven Segment Digit 1[3]
|Seven Segment Digit 1[4]
|Seven Segment Digit 1[3]
|Seven Segment Digit 1[6]
|Seven Segment Digit 2[0]
|Seven Segment Digit 2[1]
Seven Segment Digit 2[2]
Seven Segment Digit 2[3]
Seven Segment Digit 2[4]
Seven Segment Digit 2[3]
Seven Segment Digit 2[6]
Seven Segment Digit 3[0]
Seven Segment Digit 3[1]
Seven Segment Digit 3[2]
Seven Segment Digit 3[3]
Seven Segment Digit 3[4]
Seven Segment Digit 3[5]
Seven Segment Digit 3[6]
Seven Segment Digit 4[0]
Seven Segment Digit 4[1]
Seven Segment Digit 4[2]
Seven Segment Digit 4[3]
Seven Segment Digit 4[4]
Seven Segment Digit 4[5]
Seven Segment Digit 4[6]
Seven Segment Digit 5[0]
Seven Segment Digit 5[1]
Seven Segment Digit 5[2]
Seven Segment Digit 5[3]
Seven Segment Digit 5[4]
Seven Segment Digit 5[3]
Seven Segment Digit 5[6]
Seven Segment Digit 6[0]
Seven Segment Digit 6[1]
Seven Segment Digit 6[2]
Seven Segment Digit 6[3]
Seven Segment Digit 6[4]
Seven Segment Digit 6[3]
Seven Segment Digit 6[6]
Seven Segment Digit 7[0]
Seven Segment Digit 7[1]

/O Standard

2.9V

2.5V

2.5V

Depending on JPT

Depending on JP7
|Depending on JPT
Depending on JPT
|Depending on JPT
|Depending on JPT
|Depending on JPT

Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JPT
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP&
Depending on JP&
Depending on JP&
Depending on JP&
Depending on JP6
Depending on JP&
Depending on JP6
Depending on JP6
Depending on JP6
Depending on JP&
Depending on JP6
Depending on JP&
Depending on JP&
Depending on JP6
Depending on JP&
Depending on JP&
Depending on JP6
Depending on JP6
Depending on JP&
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Fil= Edit View Project Assignments Processing  Teols  Window  Help

DrrTg r “')C‘ mux2tol 7 512‘@’VF,Q ei‘b&r‘ 9
Project Navigator | &% Hierarchy v|afge < ¢ mux2tol.vhd B ¢ Comg
1 Tibrary jeee;
Entity:Instance 2 use ijeee.std_logic_1164.all;
3
A% MAX 10: 1T0MOBDAF484CBG 4 Bentity mux2tol is
5 = port({ DO,DL1: in std_logic;
BB muxto1 B 6 SEL: in std_Tlogic;

LEDR[0] "ana xximi SW(0] j7oon S-7 , KEY[0],KEY[1] n'a¥n? DO,D1 : Ni01d7 N1 e

1B € > | I
1/F8| * |MNamed]* v |« Bdit] | |Filter Pins: all
| =
n Mode Name Direction Location 1/O Bank VREF Group Fitter Location /O Star
ia_ Do Input PIN_M23 B BE_ M2 PIN_ABZ28 2.5V
P _ _ .
& D1 Input PIN_m21 5 B6 N1 PIN_AC28 25V
P _ _ X
. F Output PIN_G19 7 B7_N2 PIN_G19 25V
= SEL Input PIN_AB28 5 B5_N1 PIN_M23 25V
P et LT B

n'xY7'oN17 yx11 e

USB-Blaster NX Man NI7 T '/pNn? 7Y W', USB -1 NNn Nan) e

A 4

Nn1'"X N1l e

File Edit Wiew Project Assignments Processing Tools Window Help

O ||+ D 7 C ) muxzton LS EBH D MES @ g
Project Navigator | 4 Hierarchy ~laf@e x| ¢ mux2tol.vhd B @ ol

QDrowsummary
Entity:Instance Table of Contents q Flow Summary
e e mrammmemam e o B2 Flow summane L}
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(n'wna y'om sof Nni'o Dy naMxN yalp) Start 7y yn'7a1 USB — Blaster n2Mx7 1n21 e

» Programmer - Exfvhdl/mux2tol/muxtol - muwxtol - [mux2tol.cdf]

- e

i ChangeFile...

File Edit View Processing Tools Window Help search altera.com .

e l ]

i Hardware Setup...| | USB-Blaster [USB-0] Mode: | JTAG ad Progress: ]
[J Enable real-time ISP to allow background programming when available
I wh st I File Device Checksum Usercode Program/  Verify = Blank- Examin:

Configure Check
i 5top utput_files/mux2to1.sof | 10MSODAF484 D026FCSA  DD2GFCSA
M Auto Detect
Delete
™ add File...
£ >

2 save File

r* Add Device.. T
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Down SRREEEEES
10M50DAF484
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